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l Note: If you encounter problems registering your product or accessing the lesson files or 
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ADDING TRANSITIONS

Lesson overview
In this lesson, you’ll learn how to do the following:

• Understand edit points and handles.

• Understand transitions.

• Add video transitions.

• Modify transitions.

• Fine-tune transitions.

• Apply transitions to multiple clips.

• Work with audio transitions.

This lesson will take about 75 minutes to complete. To get the lesson files 
used in this chapter, download them from the web page for this book at 
peachpit.com/PremiereProCIB2024. For more information, see “Accessing 
the lesson files and Web Edition” in the “Getting Started” section at the 
beginning of this book. Store the files on your computer in a convenient 
location.

7

http://peachpit.com/PremiereProCIB2024
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Transitions can help create a seamless fl ow between 
two video or audio clips or inform the viewer that 
a change of scene has begun. Video transitions are 
often used to signify a change in time or location. 
Audio transitions provide a useful way to avoid abrupt 
edits that jar the listener or to blend the signifi cance 
of two scenes.
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Starting the lesson
Although the most common transition is a cut—where one clip abruptly ends and 
another begins—there are great opportunities for creativity using transition effects 
you can animate.

In this lesson, you’ll learn to use transitions between video and 
audio clips to help your edits flow more smoothly. You’ll also learn 
best practices for choosing the most appropriate transitions.

For this lesson, you’ll use a new project file.

1 Start Adobe Premiere Pro, and open the project Lesson 07.prproj 
from the  Lessons folder.

2 Save the project as Lesson 07 Working.prproj in the same 
folder.

3 Use the Workspaces menu to choose Effects. Reset the work-
space to the saved layout.

This changes the workspace to a preset optimized for working 
with transitions and effects.

The workspace uses stacked panels to maximize the number of 
panels that can be onscreen at a time.

You can enable stacked panels for any panel group by opening the 
panel menu  and choosing Panel Group Settings > Stacked Panel 
Group. The same option will toggle off stacked panels.

Keep stacked panels enabled for now.

You can click the name of any stacked panel to view it. In the Effects 
panel, you can click effect category disclosure triangles to display 
their contents. The stacked panel automatically changes height to 
accommodate the listed items.

What are transition effects?
Adobe Premiere Pro offers several special effects and preset anima-
tions to help you bridge neighboring clips in a sequence. These 
transitions—such as dissolves, wipes, dips to color, and so on— 
provide a way to ease viewers from one scene to the next. As well 
as smoothing the join between two clips, transitions can be used to 
focus attention on a major jump in the story.

Choosing and configuring transitions is an art. Applying them is simple enough: 
Drag the transition you want from the Effects panel onto the edit between two clips 
in a sequence.
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The skill comes in their placement, length, and settings, such as direction, motion, 
and start/end positions.

You can adjust some transition settings in the Timeline panel, but it’s usually easier 
to make precise adjustments in the Effect Controls panel. To view the settings for a 
transition effect in the Effect Controls panel, select it in a sequence.

In addition to the unique options for each transition, the Effect Controls panel fea-
tures a helpful A/B timeline display (more on this later).

This display makes it easy to change the timing of transitions relative to an edit 
point, change the transition duration, and apply transitions to clips that don’t have 
enough head or tail frames—that is, additional content to provide an overlap at the 
beginning (head) or end (tail) of a clip.

Knowing when to use transitions
Transitions are a standard storytelling tool in video editing, and the rules for their 
use are similar to the rules of screenwriting. They’re effective when they help the 
viewer understand the story.

For example, you may switch from indoors to outdoors in a video, or you may jump 
forward in time. An animated transition, a fade to black, or a dissolve can help the 
viewer understand that the location has changed, that time has passed, or that a 
character’s perspective has changed.

A fade to black at the end of a scene is a clear indication that the scene has fin-
ished. The trick with transitions is to be intentional—and this often means using 
restraint—unless, of course, a total lack of restraint is the creative result you want!

As long as it looks like you intended to include a particular effect, your audience will 
tend to trust your decision (whether or not they agree with your creative choice). 
It takes practice and experience to develop sensitivity for the right time, and the 
wrong time, to use effects such as transitions. If in doubt, less is usually best.

There is an established visual language that modern audiences recognize and 
respond to. For example, if a character falls asleep and the picture goes soft-focus, 
with everything in the frame glowing and bright, your audience will immediately 
know that we are witnessing that character’s dream. Studying this kind of visual 
language can help you make creative choices.
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Following best practices with transitions
You may be tempted to use a transition effect on every cut. Don’t! Or at least, get 
them out of your system with your first project.

Most TV shows and feature films use cuts-only edits. You’ll rarely see any transi-
tion visual effects. Why is this? An effect should be used only if it gives an additional 
benefit; transition effects can sometimes be a distraction from the video, remind-
ing viewers they are watching a story and preventing them from connecting with it 
emotionally.

If a news editor uses a transition effect, it’s for a purpose. The most frequent use in 
newsroom editing is to transform what would have been a jarring or abrupt edit into 
a more comfortable experience.

A jump cut is a good example of a scenario where a transition effect can help. A 
jump cut is a cut between two similar shots. Rather than looking like a continua-
tion of the story, they look a little like a piece of the video is unintentionally missing. 
By adding a transition effect between the two shots, you can make a jump cut look 
intentional and less distracting.

Dramatic transition effects do have their place in storytelling. Consider the Star 
Wars movies with their highly stylized transition effects, such as obvious, slow 
wipes. Each of those transitions has a purpose. In this case, it’s to create a look remi-
niscent of old serialized movies and TV shows. The transition effects send a clear 
message: “Pay attention now. We’re transitioning across space and time.”

Understanding the importance of clip handles
To understand transition effects, you’ll need to understand edit points and handles. 
An edit point is the point in your sequence where one clip ends and the next begins. 
This is often called a cut and sometimes simply called an edit. These are easy to 
see because Premiere Pro displays vertical lines to show where one clip ends and 
another begins (much like two bricks next to each other).

When you first edit a clip into a sequence, you set an In point and an Out point 
to select the part you want. When you edit that selected part of the clip into a 
sequence, the unused sections at the beginning and end are still available but hid-
den in the Timeline panel. Those unused sections are referred to as clip handles or 
simply handles.

There’s a handle between a clip’s original beginning and the In point you set. There’s 
also a handle between a clip’s original end and the Out point you set. The time ruler 
in the Source Monitor shows you how much footage is available in your handles.
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Playhead position In/Out duration

Original 
start

Original 
end

Handle Out pointIn point Handle

Of course, you may not have used In or Out points, or you may have set just an 
In point or an Out point at the very beginning or end of the clip. In this case, you 
would have either no unused media or unused media at only one end of the clip.

In the Timeline panel, if you see a tiny triangle in the upper-right or upper-left 
corner of a clip, it means you’ve reached the end of the original clip and there are no 
additional frames available.

No handle No handle No handleHandle available

For transition effects to work, you need handles because the effect creates an over-
lap between the outgoing clip and the incoming clip.

For example, if you want to add a two-second Cross Dissolve transition centered 
between two video clips, you need at least a one-second handle available on 
both clips (one additional second each that would not normally be visible in the 
sequence). In the Timeline panel, the transition effect icon gives a visual indication 
of the duration of the effect and, therefore, the clip overlap.

Adding video transition effects
Premiere Pro gives you multiple video transition effects to choose from. Most 
options are available in the Video Transitions group in the Effects panel.

Video transitions are organized into eight subcategories. You’ll find some additional 
transitions in the Video Effects > Transition group in the Effects panel. However, 
these effects are meant to be applied to an entire clip and are used to reveal the 
visual contents of the clip over time between its start and end frames (not using clip 
handles overlapping another clip). This second category works well for superimpos-
ing text or graphics.
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Applying a single-sided transition
The easiest transition to understand is one that applies to just one end of a single 
clip. This could be a fade from black on the first clip in a sequence or a dissolve into 
an animated graphic. Let’s give it a try.

1 If it’s not already open, open the sequence called Transitions.

This sequence has four video clips and background music. The clips have 
handles, so transition effects can be applied between them (no tiny triangles are 
visible at the ends of the clips, which would indicate the last frame is already 
visible).

2 In the Effects panel, open the Video Transitions > Dissolve group. Find the Cross 
Dissolve effect.

3 Drag the effect onto the start of the first video clip. A highlight shows you where 
the transition effect will be added. When the transition is in the right position, 
release it.

4 Drag another Cross Dissolve effect onto the end of the last video clip.

The Cross Dissolve icon shows the timing of the effect. For example, the effect 
you just applied to the last clip in the sequence will start before the end of the 
clip and complete by the time it reaches the clip’s end.

Transitions of this kind don’t extend the clip (using a handle) because the transi-
tion doesn’t reach past the end of the clip.

Because you’re applying the Cross Dissolve transition effect at the end of the 
last clip, where there is no connected clip, the picture dissolves into the back-
ground of the Timeline, which is black. The result is that this looks like a Dip To 
Black effect.

l Note: To ensure 
that the tools function 
and the defaults are set 
exactly as described in 
this lesson, reset the 
Premiere Pro prefer-
ences by holding the 
Option (macOS) or 
Alt (Windows) while 
launching the applica-
tion and then clicking 
Continue in the Reset 
Options dialog box. 

l Note: You can use 
the Search field, at the 
top of the Effects panel, 
to locate an effect by 
name or keyword, or 
you can browse the 
folders of effects.
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In reality you are causing the clip to become gradually transparent in front of a 
black background. The difference is clearer when you work with multiple layers 
of clips, with different-colored background layers.

5 Play the sequence to see the result.

You should see a fade from black at the start of the sequence and a fade to black 
at the end.

Applying a transition between two clips
Let’s apply transitions between a few clips. For the purposes of exploration, you’ll 
break the less-is-best rule and try several options in one sequence. As you go 
through these steps, play the sequence regularly to view the results.

1 Continue working with the previous sequence, called Transitions.

2 Move the Timeline playhead to the edit point between clip 1 and clip 2 on the 
Timeline and then press the equal sign (=) key two or three times to zoom in 
fairly close. If your keyboard does not have the = key, use the navigator at the 
bottom of the Timeline panel to zoom. You can also create a custom keyboard 
shortcut for this purpose (see Lesson 1, “Touring Adobe Premiere Pro”).

3 Drag the Dip To White transition effect from the Dissolve group in the Effects 
panel onto the edit point between the first clip and the second clip. The effect 
will snap to one of three positions, and the pointer will change to indicate which 
position the transition will occupy.

 Tip: On an English-
language keyboard, it’s 
easy to remember that 
pressing the = key (if 
your keyboard has one) 
zooms in because there 
is usually a + symbol on 
the same key.
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Be sure to line up the effect with the middle of the edit, not the end of the first 
clip or beginning of the second clip.

The Dip To White transition effect gradually builds to a completely white screen, 
which obscures the cut between the first clip and the next.

4 In the Effects panel, click the disclosure triangle for the Slide group of video 
transitions to display its contents. Drag the Push transition onto the edit point 
between the second clip and the third clip in the sequence, centered on the cut.

5 Play through the transition to see the result, and then position the playhead on 
the edit between clip 2 and clip 3 by pressing the Up Arrow key. The Up and 
Down Arrow keys are shortcuts to move the Timeline playhead to the previous 
or next edit on targeted tracks.

6 Click the Push transition effect icon in the Timeline panel once to select it, and 
open the Effect Controls panel (remember, if you can’t see a panel, it will always 
be listed in the Window menu).

7 Change the direction of the clip from West To East to East 
To West by clicking the small direction control triangle to 
the right of the A/B thumbnail at the top left of the Effect 
Controls panel.

Each small white triangle changes the direction for the Push 
transition effect. Hover the pointer over a triangle to see a tool tip describing 
the option.

In the Timeline panel, play through the transition to see the result.

8 In the Effects panel, expand the Page Peel group in the Video Transitions cat-
egory. Drag the Page Turn transition effect onto the edit point between the third 
clip and the fourth clip, centered on the cut.

9 Review the sequence by playing it from beginning to end.

Having watched this sequence, you can probably see why it’s a good idea to use 
transitions with restraint!

Let’s try replacing an existing transition effect.

 Tip: If the Effect 
Controls panel is empty 
when you open it, 
click once on the Push 
transition effect again 
to re-select it.

Select direction
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10 Drag the Barn Doors transition from the Wipe group onto the existing Push 
transition effect icon, between the second clip and the third clip. The new transi-
tion effect replaces the old one, taking the duration and timing of the existing 
effect.

l Note: When you drag a new video or audio transition effect from the Effects panel on top of 
an existing transition, it replaces the existing effect. It also preserves the alignment and duration 
of the transition it replaces. This is a quick way to experiment with alternative transition effects.

11 Select the Barn Doors transition effect icon on the timeline so its settings are dis-
played in the Effect Controls panel. Using the controls in that panel, set Border 
Width to 7 and Anti-aliasing Quality to Medium to create a thin black border at 
the edge between the two clips.

12 Play through the transition to view the result. The best way to do this is prob-
ably to click a little earlier in the sequence to watch the video leading up to the 
transition.

If the video does not play smoothly during transition effects, press the Return 
(macOS) or Enter (Windows) key to render, wait for the rendering to complete, 
and try again. See the sidebar “Red, yellow, and green render bars” later in this 
lesson for more information about rendering.

Video transitions have a default duration, which can be set in seconds or frames 
(it’s frames by default). If the default duration is set in frames, the effective play-
back duration of a transition effect will change depending on the sequence frame 
rate. The default transition duration can be changed in the Timeline section of 
the Preferences panel.

l Note: You may need 
to scroll down in the 
Effect Controls panel to 
access further controls.
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13 Choose Premiere Pro > Settings > Timeline (macOS) or Edit > Preferences > 
Timeline (Windows). Depending on your geographic region, you may see a 
default Video Transition Duration setting of 30 Frames or 25 Frames.

14 This is a 24-frames-per-second sequence, but this doesn’t matter if you change 
the Video Transition Default Duration option to 1 second. Do so now, and 
click OK.

Existing transition effects keep their existing settings when you change the pref-
erence, but any future transitions you add will have the new default duration.

The duration of an effect can dramatically change its impact, and later in this les-
son, you’ll learn about adjusting the timing of transitions.

Apply the default transition effect to multiple clips
So far, you’ve been applying transitions to video clips. You can also apply transitions 
to still images, graphics, color mattes, and even audio, as you’ll see shortly.

It’s common for editors to create a photomontage, which might look good with 
transitions between the multiple photos. Applying transitions between two or three 
photos is quick and easy, but if you have 100 images, it will take a long time!

Premiere Pro makes it straightforward to automate this process by allowing you to 
set a default transition effect.

1 In the Project panel, find and open the sequence Slideshow.

This sequence consists of several images placed in a particular order. Notice that 
a Constant Power audio crossfade has already been applied to the beginning and 
end of the music clip to create a fade in and out.

2 Play the sequence by making sure the Timeline panel is active and pressing the 
spacebar.

There’s a cut between each clip.

3 Press the backslash (\) key to zoom out the Timeline panel so the whole 
sequence is visible. If your keyboard does not have a \ key, drag the right end of 
the Timeline panel navigator to adjust the zoom.

 Tip: If you discover 
a useful keyboard 
shortcut that uses a key 
not included on your 
keyboard, you can use 
the Keyboard Shortcuts 
dialog box to assign a 
different key.
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4 If necessary, increase the height of the V1 track to see thumbnails on the clips 
(you can drag the dividing line between V1 and V2 in the track header).

5 Using the Selection tool, draw a marquee around all the video clips to select 
them. Begin dragging in an empty area, away from the clips, or you’ll move the 
first clip you click instead.

6 Choose Sequence > Apply Default Transitions To Selection.

This applies the default transition between all the currently selected clips. 
Notice that the Constant Power audio crossfade at the beginning and end of the 
music clip is now shorter because the default audio transition duration has been 
applied.

The default video transition effect is a 30-frame or 25-frame Cross Dissolve 
(though you changed this earlier to 1 second), and the default audio transition 
effect is a 1-second Constant Power crossfade. The shortcut you used replaced 
the existing audio crossfades with new, shorter ones.

You can set the default transition by right-clicking any transition effect in the 
Effects panel and choosing Set Selected As Default Transition. The icon for the 
selected default transition effect has a blue outline.

7 Play the sequence to see the difference the new Cross Dissolves make to the 
montage.

Copy a transition effect to multiple edits
You can copy an existing transition effect to multiple edits using the keyboard.

Let’s try it.

1 Press Command+Z (macOS) or Ctrl+Z (Windows) to undo the last step, and 
press Esc to deselect the clips.

2 Select any transition effect in the Effects panel, and drag it onto the cut between 
the first two video clips in the Slideshow sequence.

3 Select the transition you just applied by clicking its effect icon once in the 
sequence.

 Tip: You’ll find the 
option to apply audio-
only or video-only 
transition effects in the 
Sequence menu too.

l Note: If you’re work-
ing with clips that have 
linked video and audio 
and Linked Selection is 
enabled in the Timeline 
panel, you can select 
just the video or audio 
portions by Option-
dragging (macOS) or 
Alt-dragging (Windows) 
with the Selection 
tool. Then choose 
Sequence > Apply 
Default Transitions To 
Selection.
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4 Press Command+C (macOS) or Ctrl+C (Windows) to copy the effect. Then hold 
Command (macOS) or Ctrl (Windows) while you use the Selection tool to drag a 
marquee around multiple other edits to select them, rather than clips.

5 With the edits selected, press Command+V (macOS) or Ctrl+V (Windows) to 
paste the transition effect onto all the selected edits.

This is a great way to add transition effects with matching settings to multiple edits, 
especially if you have taken the time to customize the effect.

Red, yellow, and green render bars
When you add a transition to a sequence, a red or yellow horizontal line (or render 
bar) may appear above it in the Timeline panel. A yellow bar indicates that Premiere 
Pro expects to be able to play the effect smoothly. A red bar means that this section 
of the sequence may need to be rendered before you can play a preview without 
dropped frames.

You can choose to render at any time 
to make these sections preview more 
smoothly on a less powerful computer.

The easiest way to render is to press the 
Return/Enter key. If you add In and Out 
points to select a part of your sequence 
and then render, only the selected sec-
tion of the sequence will render. This is useful if you have many effects that need to 
render but you’re concerned with only one part for now.

Red or yellow bars will turn to green when those sections of a sequence are 
rendered. Premiere Pro creates a video file for each section where the bar has 
turned green. The new video files are stored in the Preview Files folder (as set in the 
project’s Scratch Disk settings). As long as the render bar is green, playback should 
be smooth.
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Using A/B mode to fine-tune a transition
When you review transition effect settings in the Effect Controls panel, you have 
access to an A/B editing mode that splits a single video track into two. What would 
normally be displayed as two consecutive and contiguous clips on a single timeline 
track are now displayed as individual clips on separate tracks, with a transition 
between them. Separating the elements of the transition in this way allows you to 
manipulate the head and tail frames (or handles) and to change other transition 
options.

Changing parameters in the Effect Controls panel
You can customize all transitions in Premiere Pro. A major benefit of the Effect 
Controls panel is that, in addition to it giving you access to the settings for transition 
effects, you can see the outgoing and incoming clip handles (unused media in the 
original clip). This makes it easier to adjust the timing of an effect.

Let’s modify a transition.

1 In the Timeline panel, switch back to the Transitions sequence.

2 Position the Timeline playhead over the Barn Doors transition you added 
between clips 2 and 3, and click the transition to select it.

3 In the Effect Controls panel, select the box for Show Actual Sources to view 
frames from the actual clips.

This makes it easier to assess the changes you’ll make.

4 In the Effect Controls panel, open the Alignment menu, and choose Start At Cut.

The transition in the Effect Controls panel timeline, and in the sequence, 
switches to show the new position.
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5 Click the small Play The Transition button  at the upper-left corner of the 
Effect Controls panel to preview the transition beneath the button.

6 Now change the transition duration. In the Effect Controls panel, click the blue 
numbers for the Duration, type 300, and click away from the numbers or press 
the Tab key to apply the new setting. Premiere Pro will add the correct punctua-
tion automatically, changing 300 into 00:00:03:00—that is, 3 seconds.

The Alignment menu changes to Custom Start because the effect now reaches 
beyond the beginning of the next transition effect. To make the new transition 
duration fit, Premiere Pro automatically sets its start two frames earlier.

Examine the A/B timeline display in the Effect Controls panel timeline, at the 
right side of the panel. There is a zoom navigator at the bottom of the Effect 
Controls panel timeline that works just like the one in the Monitors and Time-
line panel. Zoom out by dragging one of the circles on the navigator to make it 
longer, so you can see the ends of the clips.

In this example, the Effect Controls panel playhead is centered on the cut, and 
you can see the way the effect timing has been adjusted automatically.

7 In the Timeline panel, play through the transition to see the change.

These automated adjustments can be subtle, so always double-check the results 
of new settings by playing through the effect. This way you can be sure you’re 
happy with the newly revealed media taken from the clip handles—the media 
that was hidden from view until you added the transition effect. Although it’s 
useful that Premiere Pro automatically modifies the timing of effects when 
necessary, it makes it even more important to check the transition before you 
move on.

Now let’s customize the transition.

8 In the Effect Controls panel timeline, hover the pointer over the middle part of 
the vertical black line that crosses all three layers (the two video clips and the 
transition effect between them). The line is the edit point between the two clips. 
If your pointer is correctly positioned, it will change to the red Rolling Edit tool.

l Note: If the Effect 
Controls panel timeline 
is not visible, click 
Show/Hide Timeline 
View  at the upper-
right corner of the 
panel. You may need to 
resize the panel to make 
the button visible.

l Note: It’s possible to 
shorten a transition to a 
duration of one frame. 
This can make it hard to 
grab and position the 
transition effect icon, so 
try using the Duration 
and Alignment controls. 
If you want to remove 
a transition, select it 
in the sequence in the 
Timeline panel and 
press Delete (macOS) or 
Backspace (Windows).

 Tip: You can posi-
tion the start time of a 
dissolve asymmetrically 
by dragging it to a new 
position. This means 
you don’t have to settle 
for the Centered, Start 
At Cut, and End At Cut 
options. You can drag 
the position of a transi-
tion effect directly on 
the Timeline too.
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This edit line is close to the left edge of the effect, so you might want to zoom in 
to the Effect Controls panel timeline to conveniently make adjustments.

In the Effect Controls panel, the Rolling Edit tool lets you reposition the timing 
of an edit between two clips by dragging the edit line.

9 Still in the Effect Controls panel, drag left and right with the Rolling Edit tool. As 
you do, you’re changing the timing of the cut. The Out point of the clip on the 
left of the edit and the In point of the clip on the right of the edit update in the 
Timeline panel when you release the drag. This is a form of trimming.

You’ll explore trimming in more detail in Lesson 8, “Editing Video—Advanced 
Techniques.”

10 Move the pointer over the transition to the left or right of the edit line in the 
Effect Controls panel, and the pointer changes to the Slide tool. If there is a blue 
line, it’s the time ruler playhead.

Using the Slide tool changes the start and end points of the transition with-
out changing its overall duration. Unlike using the Rolling Edit tool, moving 
the transition rectangle by using the Slide tool does not change the edit point 
between the two sequence clips. Instead, it changes the timing of the transition 
effect.

11 Use the Slide tool to drag the transition rectangle left and right and compare 
the results.

Using a Morph Cut effect
Morph Cut is a special transition effect that aims to be invisible. It’s designed to help 
with “talking head” video interviews, where a single speaker looks in the direction of 
the camera. If your subject pauses a lot or there is inappropriate content in the foot-
age, you may want to remove a section of the interview.

This would normally produce a jump cut (when the image seems to jump suddenly 
from one piece of content to another), but with media that changes very little over 
time, and a little experimentation, the Morph Cut effect might yield an invisible 
transition that seamlessly hides what you have removed. Let’s try it.

1 Open the sequence Morph Cut. Play the beginning of the sequence.

This sequence has one clip, with a jump cut near the start. It’s a small jump cut 
but enough to jar the audience.

 Tip: You may need 
to move the playhead 
out of the way—earlier 
or later—to see the edit 
point between two clips 
in the Effect Controls 
panel timeline.
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2 In the Effects panel, look in the Video Transitions > Dissolve group for the 
Morph Cut effect. Drag this effect to the join between the two clips.

The Morph Cut transition effect begins by analyzing the two clips. If the play-
head is over the transition effect, you’ll see a banner across the screen while the 
analysis takes place, but you can continue to work on your sequence without 
waiting.

Depending on your media, you may achieve improved results with the Morph 
Cut transition effect by experimenting with different durations.

3 Double-click the Morph Cut transition effect to display the Set Transition Dura-
tion dialog box. Change the duration to 16 frames (you can double-click any 
transition effect to access this setting).

4 When the analysis is complete, press Return/Enter to render the effect (if your 
system requires it) and play a preview.

The result is not perfect, but it’s close, and it’s unlikely an audience will notice 
the join.

Dealing with inadequate (or nonexistent) 
head or tail handles
If you try to extend a transition for a clip that doesn’t have enough frames in the 
handle for the new duration of the effect, the transition still appears but has diago-
nal warning bars through it. This means Premiere Pro is using a freeze frame to 
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extend the duration of the clip. The last available frame is held onscreen to complete 
the transition effect.

You can adjust the duration and position of the transition to resolve the issue.

1 Open the sequence called Handles.

2 Locate the edit between the two clips.

These two sequence clips have no heads or tails. You can tell this immediately 
because of the little triangles in the corners of the clips; a triangle indicates the 
first or last frame of the original clip.

3 Select the Ripple Edit tool  in the Tools panel, and use it to drag the right 
edge of the first clip to the left (begin dragging just to the left of the cut between 
the two clips). Drag to shorten the duration of the first clip to about 1:10, and 
then release. A tool tip appears while you trim to show the new clip duration.

The clip to the right of the edit point ripples (moves) left to close the gap. Notice 
that the little triangles at the end (the right edge) of the clip you just trimmed are 
no longer present.

4 Drag the Cross Dissolve transition effect from the Effects panel onto the edit 
point between the two clips.

You’ll discover that you can drag the transition onto the right side of the edit 
but not the left. That’s because there’s no handle available at the beginning of 
the second clip to create a dissolve that overlaps the end of the first clip without 
using freeze frames.

5 Press the V key to select the Selection tool, or click to select the tool  in the 
Tools panel. In the Timeline panel, click the Cross Dissolve transition once to 
select it. You may need to zoom in to make it easier to select the transition.
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6 In the Effect Controls panel, set the duration of the effect to 1:12.

The clip handle is not long enough 
to create this effect; the diagonal 
lines on the transition, both in the 
Effect Controls panel and in the 
Timeline panel, indicate Premiere Pro automatically added a freeze frame to fill 
the duration you set.

7 Play the transition to see the result.

8 In the Effect Controls panel, change 
the alignment of the transition to 
Center At Cut.

9 Drag the Timeline panel playhead 
slowly through the transition and watch the result.

• For the first half of the transition (up to the edit point), the B clip is a freeze 
frame, while the A clip continues to play.

• At the edit point, the A clip and the B clip start to play.

• After the edit, a short freeze frame is used.

There are several ways to fix this kind of issue.

• You can change the duration or timing of the transition effect.

• You can drag the edit in the Timeline panel using the Rolling Edit tool  
(click and hold the Ripple Edit tool in the Tools panel to access it) to change 
the timing of the transition in the Timeline panel. Be sure to drag the edit 
between the clips and not the transition effect. This won’t necessarily remove 
all the freeze frames, but it may improve the overall result.

• You can drag one side of the edit in the Timeline panel using the Ripple Edit 
tool  to shorten a clip, increasing the length of the handle. Again, be sure 
to click the edit between the clips and not the effect icon.

You’ll learn more about the Rolling Edit and Ripple Edit tools in Lesson 8. For now, 
make sure you have the Selection tool selected.

l Note: The Rolling 
Edit tool lets you move 
the transition earlier 
or later but does not 
change the overall 
length of the sequence 
because it extends one 
clip while shortening 
another.
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Adding audio transition effects
Audio transitions can dramatically improve a sequence’s soundtrack by remov-
ing unwanted audio pops or abrupt edits. Audiences are usually much more 
aware of inconsistency in the soundtrack than they are of the overall quality of the 
soundtrack, and crossfade transitions can have a big impact in smoothing variation 
between clips.

Creating a crossfade
There are three styles of crossfade.

• Constant Gain: The Constant Gain crossfade (as its name implies) transitions 
audio by using a constant audio gain (volume) adjustment between the clips. 
Although this transition can lead to a slight perceived dip in the audio level for 
the listener, some editors find it useful. It’s most useful in situations where you 
do not want much blending between two clips but rather more of a dip out and 
in between the clips.

• Constant Power: This is the default audio transition. It creates a smooth, 
gradual transition between two audio clips. The Constant Power crossfade works 
in a similar way to a video dissolve. The outgoing clip fades out slowly at first 
and then faster toward the end of the clip. For the incoming clip, the opposite 
occurs—the audio level increases quickly at the start of the incoming clip and 
more slowly toward the end of the transition. This crossfade is useful in situa-
tions where you want to blend the audio between two clips, without a noticeable 
drop in level in the middle.

• Exponential Fade: The Exponential Fade transition creates a fade between clips. 
It uses a logarithmic curve to fade out and fade up audio. Some editors prefer the 
Exponential Fade transition when performing a single-sided transition (such as 
fading in a clip from silence at the start or end of a program).

Applying audio transitions
There are several ways to apply an audio crossfade to a sequence. You can, of course, 
drag an audio transition effect just as you would a video transition effect, but there 
are also useful shortcuts to speed up the process.

Audio transitions have a default duration, measured in seconds or frames. You 
can change the default duration by choosing Premiere Pro > Settings > Timeline 
(macOS) or Edit > Preferences > Timeline (Windows).

Let’s take a look at the three methods for applying audio transitions.
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1 Open the sequence called Audio and switch to the Selection tool.

The sequence has several clips with audio.

2 Play the sequence to review the contents.

3 Open the Audio Transitions > Crossfade group in the Effects panel.

4 Drag the Exponential Fade transition to the start of the first audio clip.

5 Right-click the right edge of the last clip in the sequence and choose Apply 
Default Transitions.

A default video transition and default audio transition are added to the end of 
the clip.

6 You can change the length of any transition by dragging its edge in the Timeline. 
Drag to extend the audio transition you just created, and then listen to the result.

To polish the project, next you’ll add an opening Cross Dissolve transition effect 
to the video clip at the beginning of the sequence. Press Esc to deselect the tran-
sition effect you just adjusted.

7 Move the playhead near the beginning of the sequence, and press Command+D 
(macOS) or Ctrl+D (Windows) to add the default video transition.

You now have a fade from black at the beginning and a fade to black at the end. 
Now let’s add a series of short audio dissolves to smooth out the sound mix.

8 Ordinarily, making a marquee selection in the Timeline panel would select clips, 
but you can override this by holding a modifier key and select edits instead.

l Note: The selection of clips does not have to be contiguous in the Timeline panel. You can 
Shift-click clips to select individual clips in a sequence.

Using the Selection tool, while holding Command+Option (macOS) or Ctrl+Alt 
(Windows), drag a marquee selection over all of the audio edits between the 
clips on track Audio 1, being careful not to select any video clips—drag from 
below the audio clips to avoid accidentally selecting items on the video track.

l Note: To add only 
an audio transition, 
hold Option (macOS) 
or Alt (Windows) when 
right-clicking to select 
only the audio clip.

 Tip: When using 
keyboard shortcuts to 
apply transition effects, 
Premiere Pro uses track 
targeting or clip selec-
tion to work out where 
exactly the effects 
should be applied.
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Holding Command/Ctrl allows you to select edits rather than clips. Holding 
Option/Alt temporarily unlinks the audio clips from the video clips to isolate 
those edits while making a selection.

9 Press Shift+D to apply the default transition effect to all selected clips. You 
 exclusively selected audio clips, so Premiere Pro knows to add only audio transi-
tion effects.

You could have pressed Shift+Command+D (macOS) or Shift+Ctrl+D 
( Windows), which is the shortcut to add an audio-only transition. This is useful 
if you have selected both video and audio clips and want to apply audio transi-
tion effects only.

Command+D (macOS) or Ctrl+D (Windows) applies the default video-only 
transition.

10 Deselect the transitions by clicking an empty area of the Timeline panel or by 
pressing Escape. Play the sequence to see and hear the changes you have made.

11 Choose File > Close to close the current project. Click Yes to save the file if you 
are prompted.

It’s common for audio editors to add one-frame or two-frame audio transitions to 
every cut in a sequence to avoid jarring pops when an audio clip begins or ends. If 
you set the default duration for audio transitions to two frames, you can select mul-
tiple clips and then choose Sequence > Apply Audio Transition to quickly smooth 
your audio mix.

l Note: If you’d like more transition effects, check the Adobe website. Visit helpx.adobe.com/
premiere-pro/plug-ins.html. There, you’ll find several third-party effects to explore.

 Tip: You could 
choose Apply Audio 
Transition from the 
Sequence menu to add 
transitions exclusively 
to audio clips, but if you 
have already chosen 
audio-only clips, there’s 
no need, as the default 
transition option will 
have the same effect.

http://helpx.adobe.com/premiere-pro/plug-ins.html
http://helpx.adobe.com/premiere-pro/plug-ins.html
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Review questions
1 How can you apply the default transition to multiple clips in a sequence?

2 In the Effects panel, how can you locate a transition effect by name?

3 How do you replace one transition with another?

4 What are three ways to change the duration of a transition?

5 What is an easy way to gradually increase the audio level at the beginning of a clip?
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Review answers
1 Select the clips, and choose Sequence > Apply Default Transitions To Selection.

2 Start typing the transition name in the search box in the Effects panel. As you type, 
Premiere Pro displays all effects and transitions (audio and video) that have that letter 
combination anywhere in their names. Type more letters to narrow your search.

3 Drag the replacement transition on top of the transition you’re rejecting. The new 
transition inherits the timing of the effect it replaces (but not other settings, like border 
colors).

4 Use the Selection tool to drag the edge of the transition icon in the Timeline, do the 
same thing in the A/B timeline display in the Effect Controls panel, or change the 
 Duration value in the Effect Controls panel. You can also double-click the transi-
tion icon in the Timeline panel and change the Duration value in the dialog box that 
appears.

5 Apply an audio crossfade transition to the beginning of the clip.
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5:1 audio, 48, 278
8-bit video, 367
32-bit color effects, 336
180° video, 59, 82, 162
360° video, 14, 59, 82, 111, 162

See also VR video

A
A/B timeline display, 187, 197, 198
accelerated effects, 336
action-safe area, 54, 110, 442–443
adaptive audio tracks, 48
additive color, 382, 406
adjustment layers

applying effects using, 340–342, 359–360
creating a color look using, 401–402

Adobe After Effects, 15, 77, 342–344, 460, 483
Adobe Audition, 15, 216, 292, 311, 326–327
Adobe Character Animator, 15
Adobe Color service, 437
Adobe Creative Cloud. See Creative Cloud
Adobe Dynamic Link, 15, 77
Adobe Express, 14
Adobe Fonts, 435, 460
Adobe Illustrator, 15, 80–81
Adobe Media Encoder, 14, 15, 16, 69, 470, 480–484
Adobe Photoshop. See Photoshop
Adobe Premiere Rush, 14, 17
Adobe Stock, 285–286, 485
aligning text, 439, 441–442
alpha channels

explanation of, 406–407, 410
rendering only, 481
transparency adjustments, 415–416

amplitude, 284
anchor points, 246, 254, 255
animation

of clip size changes, 258–259
keyframe interpolation and, 260–263
toggling on and off, 247, 251, 259
See also Motion effect

Appearance preferences, 28
aspect ratios, 263–265, 473, 476
assembly edits, 145–146
audio, 12, 272–329

Adobe Stock, 285–286
characteristics of, 283–285
clarity improvements, 316–317

creative adjustments, 318
dialogue adjustments, 307–325
display format options, 53–54
dragging without video, 157
ducking applied to, 293–294
editing in Audition, 326–327
effects for improving, 306–307, 319–325
Enhance Speech feature, 316
export options for, 478, 479
gain adjustments, 289–290
hardware preferences, 2
installing plug-ins for, 323
interface setup, 275–283
loudness options, 308–309
mix setting, 277–278
monitoring process, 283
noise reduction, 310, 311–314, 326–327
normalizing, 290–292
Pan and Balance controls, 289
recording voice-over, 83–84
repairing or cleaning up, 310–316, 326–327
retiming with Remix, 295–296
reverb reduction, 310, 315–316
samples and sample rate, 53, 280–281
sending to Audition, 292
speed changes and, 216, 218–219
split edits, 296–297
syncing with video, 116
track types, 47–48, 283
transitions, 203–205
volume adjustments, 287–292, 297–302, 318
waveforms, 281–282

audio channels, 113–115, 278
Audio Clip Mixer, 24, 277, 300–302
audio effects, 306–307, 319–325, 333

Notch Filter effect, 324–325
Parametric Equalizer effect, 320–323
See also video effects

audio meters, 278–279, 323
Audio Mix setting, 277–278
Audio Track Mixer, 277
Audio workspace, 275–277
Audition, Adobe, 15, 216, 292, 311, 326–327
Auto Bezier interpolation, 261, 353
Auto Reframe effect, 263–265
Auto Save feature, 28–29, 57
automatic clip selection, 370
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masking, 421–425
media files vs., 64–65
merging, 116
moving, 175–178
naming, 68, 103–104, 122, 128
nesting, 265
nudging, 176–177
playback speed, 106, 210, 212–219
playing, 105–106, 108–109
previewing, 73, 75
range selections, 125–128
rearranging, 177–178
removing, 178–181
replacing, 220–223
repositioning, 249–250
resizing, 255–257
rotating, 253–254
selecting, 171–173, 204
source, 344–347
splitting, 173–174
subclips created from, 129–130
volume adjustments, 297–302

closed captions, 461–463
codecs, 44, 476–478
collaboration, 485
color balance. See white balance
color correction, 12, 364–403

color grading vs., 368, 384
Color workspace for, 369–370
Comparison view for, 384–386
creating a distinctive look through, 401–402
effects related to, 387–389, 399–400
exposure problems and, 389–394
guidelines for checking, 394
Lumetri Color panel for, 370–374, 395–399, 400
Lumetri Scopes panel for, 375–384
matching colors for, 386–387
Ultra Key effect and, 421
white balance and, 394–399
workflow for, 368–384

color grading, 368, 384
Color Picker, 434
color space, 376
color wheels, 372, 395–396
Color workspace, 369–370, 388
colors

label, 68, 102–103
matching, 386–387
primary and secondary, 382
text, 436–437

comment markers, 163
Comparison view, 384–386

B
backdrop for text, 447
background noise removal, 326–327
backups, file, 28–29
Balance control, 289
Basic 3D effect, 268–269
Bezier interpolation, 261, 353
bins, 11, 22, 96–104

creating new, 39, 96–97
customizing, 106
filtering content in, 93–95
managing media in, 97–98
naming/renaming, 97
Project panel and, 79, 99
Search Bin creation, 102
view options for, 99–102

bit depth, 46, 336
Black & White effect, 337–338
blend modes, 411

alpha channels and, 416
combining tracks using, 414–415
video effects and, 342

Brightness & Contrast effect, 348, 391–392
Button Editor, 111–112, 140, 276, 323, 458

C
captions, 461–465

closed, 461–463
converting to graphics, 465
creating new, 463–465
open, 461

Captions and Graphics workspace, 430
Center Align Text button, 439
chapter markers, 163
chroma key effects, 409, 417–421
Clamp Signal option, 376, 379
Clarity options, 316–317
Clip Name effect, 359–360
clipboard, 178
clips, 10, 36

closing, 107
conforming, 41, 134
copying/pasting, 178
disabling, 181
dragging, 175–176
finding, 92–96
grouping, 174
handles of, 188–189, 200–202
importing, 72–75
label colors for, 102–103
linking and unlinking, 175
markers added to, 166–167
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Drag Audio Only icon, 111, 157, 281
Drag Video Only icon, 111, 157
dragging clips, 175–176
drop shadows

motion effects and, 266, 267–268
text styles and, 448

drop zone, 26
dropped frames, 49–50
ducking audio, 293–294
duration

audio transition, 203
display showing, 93, 110
pre-roll and post-roll, 238
setting for still images, 148
speed changes related to, 215–217, 219
video transition, 193–194, 198, 202

Dynamic Link, 15, 77, 342
dynamic trimming, 237–238

E
Ease In/Out controls, 262–263, 353
Edit Original option, 81
editing

multicamera, 13
nonlinear, 10
Text-Based, 223–227
touchscreen, 107
See also video editing

Editing workspace, 21, 122
edits

assembly, 145–146
delete, 180–181
extract, 170–171, 180
four-point, 145, 210–212
insert, 142–144, 156–157
lift, 179–180
overwrite, 141–142, 169
replace, 220–222
ripple, 230–231
rolling, 231–232
slide, 233
slip, 232–233
split, 296–297
three-point, 144–145

Effect Controls panel, 23
audio effects, 307, 313, 319–325
Brightness & Contrast controls, 348
Filter Properties menu, 260
Motion effect controls, 245–247, 248
transition options, 187, 192, 197–199
video effects, 337, 338, 346–347
volume adjustments, 287–288

effects. See audio effects; video effects

compositing, 404–427
alpha channels used in, 415–416
blend modes used in, 414–415
color keying greenscreen shots for, 417–421
Opacity effect used in, 411–415
partially masking clips for, 421–425
preprocessing footage for, 410
shooting videos for, 409
terminology related to, 410–411

conforming process, 41, 84, 134
Constant Gain crossfade, 203
Constant Power crossfade, 203
Continuous Bezier interpolation, 261, 353
contrast, text, 437
Copy Media option, 39
copying/pasting

clip segments, 178
transition effects, 195–196
video effects, 339

creative adjustments
for audio, 318
for color, 371

Creative Cloud
components overview, 14–15
media file storage, 29, 57

credits, 430, 458–459
Cross Dissolve effect, 190–191, 195
crossfade transitions, 203
curves adjustments, 372, 397–399
cuts, 186, 188

D
DCP format, 480
decibel (dB) scale, 279, 309
DeEss audio option, 310
default settings, 16, 38, 64
DeHum audio option, 310–311, 325
DeNoise effect, 312–314
DeReverb effect, 315–316
dialogue adjustments, 307–325

audio effects, 319–325
clarity options, 316–317
Creative Reverb effect, 318
Enhance Speech feature, 316
loudness settings, 308–309
noise reduction, 310, 311–314
repair or cleanup features, 310
reverb reduction, 310, 315–316
volume settings, 318
See also voice-overs

Dip to White transition, 191–192
Directional Blur effect, 338–339
Display Color Management feature, 367, 394
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F
Feet + Frames options, 53
file formats

choosing for export, 473, 480
supported by Premiere Pro, 10, 71, 485
video and audio, 44

files, project, 17, 18, 28, 36, 146
See also media files

Fill color swatch, 434
Filter Bin Content box, 94–95
Final Practice project, 486–487
Find dialog box, 95–96
finding assets

Effects panel for, 335, 337
Project panel for, 92–96
Timeline panel for, 167–168

Fit Clip dialog box, 210–211, 212
fixed effects, 244, 332–334, 339
Flash cue points, 163
flicker reduction, 246
folders, importing, 82
fonts

factors for choosing, 436
resizing in Project panel, 27, 100
warning about missing, 460

four-point editing, 145, 210–212
frame rate, 37, 117, 213, 214–215
Frame Size options, 45
frames, 37

display option, 53
dropped, 49–50
exporting single, 472–473
stepping through, 109

Freeform view, 75, 92, 100, 112, 146–148
freeze frame, 200–201, 202
frequency, audio, 284
FX badges, 181, 212, 338, 351, 412, 413

G
gain adjustments, 289–290
gaps, finding/removing, 170–171
Gaussian Blur effect, 341, 399
GPU acceleration, 3, 13, 46, 51–52, 336
GPU cards, 3, 336, 357
graphics

adding image files to, 454–455
creating in Photoshop, 451
importing into projects, 76–81
layered Photoshop files as, 77–80
Motion Graphics templates for, 58, 459–461
saving Source, 450
single-layer files as, 77
upgrading captions to, 465

Effects panel, 23, 334–335
audio effects, 306–307, 319–325
color-adjustment effects, 388–389
finding effects in, 335, 337, 388
video effects, 334–337

Ellipse tool, 431, 453
Enhance Speech feature, 316
Essential Graphics panel, 430–435

Appearance options, 434, 444, 446, 447–448
Browse tab, 430, 459, 460
Edit tab, 430, 432, 438, 439, 440, 458
formatting text in, 438, 439, 440–441, 458
layers used in, 432–433, 454
rolling titles or credits in, 459
styling text in, 447–449

Essential Sound panel, 306–318
clarity adjustments, 316–317
creative adjustments, 318
dialogue adjustments, 307–319
ducking options, 293–294
Effect Controls panel and, 313
Enhance Speech feature, 316
improving audio with, 306–307
loudness settings, 308–309
noise reduction, 310, 311–314
presets used in, 308, 319
reverb reduction, 310, 315–316
stock audio clips in, 285–286
volume adjustments, 318

Exponential Fade transition, 203
Export Settings dialog box, 482, 483
exporting, 468–485, 488–489

aspect ratios for, 476
codecs chosen for, 476–478
collaborating and, 485
configuration settings for, 480–481
effects applied during, 479
file formats for, 473, 480, 485
full quality media files, 473–479
markers, 167
overview of options for, 471–472
queuing media files for, 481–483
quick option for, 24, 470–471
sequences, 14
single frames, 472–473
to social media, 484–485
source range for, 475

exposure fixes, 389–394
overexposed images, 393–394
underexposed images, 391–393

extract edits, 170–171, 180
eyedroppers, 396, 398–399, 418–419, 434
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indexed MPEGs, 84
Info panel, 24
ingest settings, 58–59, 68–70
insert edits, 142–144, 156–157
installing Premiere Pro, 2
instances, clip, 103
interpolation methods, 260–261, 351–352, 353
interpretation

audio channel, 114–115
video footage, 117, 123, 214

J
J-cut edits, 296–297
jump cuts, 188

K
kerning text, 437–438
Key Color eyedropper, 418–419
keyboard shortcuts, 20, 29–31

for adding markers, 166
for In and Out points, 138, 180
for nudging clips, 177
for ripple edits, 231
for toggling snapping, 175
for trimming, 239
for volume adjustments, 299

Keyboard Shortcuts dialog box, 194
keyframes, 12–13, 244, 260–263

adding to clips, 350–351
clip vs. track, 300
Ease In/Out controls for, 262–263
interpolation methods for, 260–261, 351–352, 353
opacity adjustments with, 413–414
Velocity graph for, 351, 353–354
video effects using, 349–354
volume adjustments with, 299–300

keying process, 310, 406, 409, 410
keywords, 460

L
label colors, 68, 102–103
layers

Essential Graphics panel, 432–433, 454
Photoshop, 77–79, 80, 98

L-cut edits, 297
leading, text, 440–441
Learning workspace, 24
Lens Flare effect, 350–354
lesson files, 3, 4–5, 18
letterboxing, 257
Libraries panel, 23, 57
lift edits, 179–180
Linear interpolation, 260, 353

greenscreen, 411
color keying shots made with, 417–421
shooting videos using, 409

Grid view, 40, 72
grouping

clips, 174
panels, 21–22

guides and rulers, 456–458

H
H.264 codec, 471, 478, 480
handles, clip, 188–189, 200–202
hard drives

finding media files on, 98–99
typical setup for, 57

HDR video, 54, 376
headers, track, 83, 140
History panel, 24
Hold interpolation, 261, 353
Home screen, 16–17, 21
hover scrubbing, 105
HSL Secondary settings, 372
Hue Saturation Curves controls, 397–399

I
Icon view, 19, 75, 79, 99, 101
Illustrator program, 15, 80–81
image stabilization effect, 357–359
images. See still images
immersive video. See VR video
Import command, 67–68
Import Into Project option, 482
Import mode

adding clips using, 72–73
Favorite Location button, 76
Media Browser panel vs., 65–67

importing, 62–87
customizing media cache for, 84–86
file formats supported for, 71
folders and subfolders, 82
Illustrator files, 80–81
ingest process and, 58–59, 68–70
layered Photoshop files, 77–79, 98
media files, 64–75
proxy file creation and, 68–70
still image files, 76–81
VR video, 82

In and Out points
clearing or removing, 138
options for setting, 110, 137, 180, 225
Source Monitor, 123, 125, 126–128, 228
three-point editing with, 144–145
Timeline panel, 137–138



ADOBE PREMIERE PRO CLASSROOM IN A BOOK 2024 RELEASE 495

media cache, 84–86
Media Encoder, 14, 15, 16, 69, 470, 480–484
media files

clips vs., 64–65
compressed, 409
exporting, 14, 473–479
Final Practice project, 486–487
guidelines for working with, 70–71
importing, 64–75
locating on drives, 98–99
managing in bins, 97–98
organizing, 90–104
proxy, 68–70

Mercury Playback Engine, 13, 51–52, 159
merging clips, 116
metadata, 13, 106, 113, 478, 481
Monitor panels. See Program Monitor; Source 

Monitor
mono audio, 48, 278
Morph Cut effect, 199–200
Motion effect, 243, 244–259, 333

adjusting, 244–250
animating size changes, 258–259
options for working with, 245–250
position changes, 245, 250–251
reusing settings for, 251–253
rotation option, 245, 253–255
scale settings, 245, 255–257

Motion Graphics templates, 58, 459–461
motion paths, 261, 352
moving clips, 175–178
MPEG4 file format, 478
multicamera editing, 13
multichannel audio, 278
music tracks. See audio

N
narration. See voice-overs
nesting

clips, 265
sequences, 22, 133

network-based storage, 57
noise reduction, 310, 311–314, 326–327
nonlinear editor (NLE), 10
normalizing audio, 290–292, 479
Notch Filter effect, 324–325
nudging clips, 176–177
numeric keypad, 126

O
online content, 3–4
opacity, 407, 411, 413–414, 417
Opacity effect, 333, 411–415

linking/unlinking clips, 175
List view, 20, 39, 75, 79, 92, 99, 101
locking

guides, 457
tracks, 168–170

looped playback, 112, 127, 238, 323
loudness adjustments, 308–309, 479
Lumetri Color effect, 346–347, 389, 400
Lumetri Color panel, 369, 370–374

adjusting settings in, 373–374
built-in looks, 400, 401–402
example of using, 374
match color feature, 386–387
Reset Effect button, 380
sections and controls, 370–373
white balance adjustments, 395–399

Lumetri Color presets, 389, 400
Lumetri Look effects, 479
Lumetri Scopes panel, 369, 375–384

RGB parade, 383–384
waveform display, 377–380
YUV vectorscope, 380–383

LUT files, 371, 400

M
Maintain Audio Pitch option, 216
margins, safe, 110–111, 442–443
Mark In/Out buttons, 110, 125, 126, 137
markers, 163–167

adding, 125, 164, 166
clip, 166–167
explanation of, 163
exporting, 167
sequence, 163–166
types of, 163

Markers panel, 164, 166, 167
masking

composited clips, 421–425
text used for, 455–456
video effects, 347–349

Match Frame command, 256
Match Sequence Preview Settings option, 474
Match Source settings, 471
matching colors, 386–387
mattes, 410–411

creating custom, 422–423
generating and adjusting, 420–421

MDS verification, 69
Media Browser panel, 23

adding clips using, 73–75
browsing inside projects with, 67
folder imports using, 82
Import mode vs., 65–67
navigation features, 76



496 INDEX

Position control, 245, 250–251
poster frames, 102
preferences

introduction to setting, 27–29
resetting to default, 16, 38, 64

Premiere Rush, 14, 17
presets

audio effect, 308, 319
built-in, 354–355
file export, 471, 477, 480
Lumetri Color, 389
saving, 355–357
sequence, 43–44, 46
video effect, 339, 354–357

previews
exporting files of, 482
Project panel, 92
thumbnail, 73, 75

primary and secondary colors, 382
Program Monitor, 23, 25, 152–158

adding clips with, 154–156
Comparison View, 384–386
customizing display of, 111–112
insert editing with, 156–157
overview of, 152–153
rulers and guides, 456–458
selecting layers in, 435
Source Monitor vs., 153
trimming in, 234–238
See also Source Monitor

project files, 17, 18, 28, 36, 146
Project panel, 22, 90–96

bins and, 79, 99
customizing, 91–92
editing video from, 127
features overview, 90–91
filtering bin content in, 93–95
finding assets in, 92–96
label colors in, 102–103
renaming items in, 104
viewing clips in, 75

Project Settings dialog box, 49, 69
project-based storage setup, 55, 56
projects

browsing, 67
closing multiple, 465
creating new, 17, 38–41
managing, 13, 18
opening, 17, 67

ProRes 422 HQ codec, 478
proxy media, 59, 68–70, 216, 482

open captions, 461
Optical Flow option, 219
organizing media, 90–104

bins used for, 96–104
Project panel for, 90–96

overcranking technique, 213
overexposed images, 393–394
overlay options, 111, 155, 479
overwrite edits, 141–142, 169

P
Pan control, 289
panel menu, 24, 27
panels, 20

active, 124
grouping, 21–22
monitor, 23
overview of, 22–24
resizing, 25, 27
stacked, 186

paragraph text, 443, 446–447
Parametric Equalizer effect, 306, 320–323
Paste Attributes dialog box, 252
Paused Resolution setting, 161–162
pauses, removing, 226
peak level, 309
Pen tool, 299, 431, 452–453, 454
performance

optimizing, 2–3
playback, 52

phase, audio, 284
photomontage, 194–195
Photoshop, 15

creating graphics or titles in, 451
importing layered files from, 77–79, 98
working with files from, 80

pillarboxing, 257
pixel aspect ratio, 117
playback

controls for, 108–109
looping, 112, 127, 238, 323
Mercury Playback Engine and, 51–52
methods for performing, 105–106, 108–109
performance of, 52
real-time, 49–50, 51
rendered, 51
resolution for, 109, 159–162
speed controls for, 106, 210, 212–219
VR video, 162

plug-ins, 323
point text, 443–446
Polygon tool, 431, 453



ADOBE PREMIERE PRO CLASSROOM IN A BOOK 2024 RELEASE 497

sequences, 10, 12, 22, 36–37
adding clips to, 154–156
audio tracks in, 47–48
configuring settings for, 37, 45–47
conforming clips in, 41, 134
creating new, 39, 133–134
directly importing, 483
explained, 133–134
extract edits in, 170, 180
finding/removing gaps in, 170–171
insert edits in, 142–144, 156–157
lift edits in, 179–180
markers added to, 163–166
matching settings in, 42–43, 474–475
nested, 22, 133
opening in Timeline, 134
overwrite edits in, 141–142
presets for, 43–44, 46
rearranging clips in, 177–178
removing clips from, 178–181
rendering parts of, 196
selecting clips in, 172, 204
setting up, 41–48
trimming in, 228–229

Set Poster Frame button, 92
shadow effects. See drop shadows
shapes, creating, 452–454
shot types, 128
single-layer image files, 77
single-sided transitions, 190–191
slide edits, 233
Slide tool, 199, 233
slip edits, 232–233
Slip tool, 232–233
slow motion effect, 212–214, 215
snapping feature, 20, 175–176
social media uploads, 484–485
Solarize effect, 354–355, 400
Solo button, 279, 283
Sort Icons menu, 101
sound editing options. See audio
source clip effects, 344–347
Source Graphics, 450
Source Monitor, 23, 25, 123–130

controls overview, 125
customizing display of, 111–112
In and Out points, 123, 125, 126–128, 228
opening clips in, 124
playback controls, 108–109
Program Monitor vs., 153
timecode display, 110
trimming in, 228
Zoom Level menu, 107–108
See also Program Monitor

Q
queuing exports, 481–483
Quick Export option, 24, 470–471

R
Rate Stretch tool, 218–219
Razor tool, 173
real-time playback, 49–50, 51
recording voice-overs, 83–84
Rectangle tool, 431, 453
regular trim, 228, 234
Remix tool, 295–296
rendering

effects in a sequence, 51, 360
maximum quality option for, 46, 481
parts of sequences, 196
real-time playback vs., 51
and replacing, 361

replace edits, 220–222
Replace Footage command, 222–223
Reset button, 247, 259
Reset To Saved Layout command, 20
resolution, playback, 109, 159–162
resources, Adobe, 6–7
Reverb effect, 318
reverb reduction, 310, 315–316
Reverse Speed option, 216, 217
reviewing footage, 104–112
RGB color, 80, 367
RGB parade, 383–384
Ripple Edit tool, 201, 202, 230–231
ripple edits, 230–231, 234
rolling credits, 458–459
Rolling Edit tool, 198–199, 202, 231–232, 297
rolling edits, 231–232, 234
Rotation control, 245, 253–255, 445
rubber bands, 288, 297–298, 412, 413
rulers and guides, 456–458
rumble reduction, 310

S
safe margins display, 110–111, 442–443
saving, automated, 28–29, 57
Scale controls, 245, 255–257, 258, 444–445, 476
Scene Edit Detection, 131
scratch disks, 54–58
scrubbing, 84, 139, 288
SDR Conform option, 479
Search Bin creation, 102
second monitor, 124
segmentation markers, 163
Selection tool, 24, 133, 172, 173, 229, 230, 231
Send To Media Encoder button, 482, 483
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safe margins for, 442–443
strokes added to, 446, 447
styles for, 447–449
tracking, 439
See also titles

Text panel, 223, 224–227, 446
Text-Based Editing, 223–227

adding content using, 226–227
removing content using, 223–226
transcription features for, 223, 224

three-point editing, 144–145
thumbnails

navigating, 105–106
previewing clips from, 73, 75
resizing, 39, 72, 74, 101, 146

Time Interpolation option, 481
Time Remapping effect, 333
time rulers, 19, 127, 138–139
Time Tuner option, 479
timecode display, 53, 110, 126, 127, 156, 382
Timecode panel, 139–140
Timeline panel, 22, 131–140

colored lines on, 50, 196
facts about, 131–132
features illustration, 131
finding clips in, 167–168
In and Out points, 137–138
locking tracks on, 168–170
opening sequences in, 134
showing clip names and labels in, 68
targeting tracks in, 136
time rulers, 19, 138–139
track headers, 140
trimming in, 228–229

titles, 13, 430–450
appearance options for, 447–448
creating for video, 443–447
Essential Graphics panel for, 430–435
Photoshop for creating, 451
safe margins for, 442–443
stylizing text for, 447–449
typography essentials for, 436–443
See also text

title-safe area, 54, 110, 442–443
Toggle Animation button, 247, 251, 259
Toggle Track Output button, 79, 253, 445
tone mapping, 373, 479
Tools panel, 24, 133
touchscreen editing, 107
track headers, 83, 140
track locks, 170
Track Matte Key effect, 423–425

Source Range controls, 475
spatial interpolation, 261, 352
special effects. See audio effects; video effects
speed controls, 106, 210, 212–219
SpeedLooks effect, 401–402
spill suppression, 421
split edits, 296–297
splitting clips, 173–174
stacked panels, 186
standard audio tracks, 48, 283
stereo audio, 278
still images

adding to graphics, 454–455
exporting single frames as, 472–473
importing into projects, 76–81
setting duration for, 148
See also graphics

stock audio clips, 285–286
storage setups, 54–58
storyboards, 145–148
strokes, text, 446, 447
styles, text, 447–449
Stylize effects, 400
subclips, 129–130
subtractive color, 382
sync locks, 168–169
synchronizing

audio with video, 116
replace edits, 221–222
user settings, 31

system requirements, 1, 3
system-based storage setup, 55, 56

T
Team Projects, 17
television screens, 110–111, 367, 394
templates, Motion Graphics, 58, 459–461
temporal interpolation, 261, 352
text

aligning, 439, 441–442
captions as, 461–465
colors for, 436–437
contrast needed for, 437
fonts for, 436
kerning, 437–438
leading for, 440–441
lower-third, 430
masking with, 455–456
paragraph, 443, 446–447
point, 443–446
rolling, 458–459
rotating, 445
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dragging without audio, 157–158
interpreting footage from, 117, 123, 214
reviewing, 104–112
supported files types, 71
syncing audio with, 116
transition effects, 189–196
VR, 14, 59, 82, 162

video editing
advanced techniques of, 208–241
delete edits in, 180–181
extract edits in, 170, 180
four-point, 145, 210–212
insert edits in, 142–144, 156–157
lift edits in, 179–180
opening clips for, 124
overwrite edits in, 141–142
Program Monitor for, 152–158
Project panel for, 127
replacing clips/footage, 220–223
second monitor used in, 124
selecting parts of clips for, 125–128
sequences used in, 133–134
Source Monitor for, 123–130
speed/duration changes, 212–219
storage setups for, 54–58
storyboards for, 145–148
subclip creation in, 129–130
three-point, 144–145
Timeline panel for, 131–140
tracks used in, 135–136
transitions used in, 184–207
trimming as, 228–239

video effects, 330–363
adjustment layers for, 340–342, 359–360
After Effects used for, 342–344
applying to clips, 337–339
Clip Name effect, 359–360
color-adjustment, 387–389, 399–400
copying/pasting, 339
Effects panel, 334–335
exporting media with, 479
finding, 190, 335, 337, 388
fixed, 244, 332–334, 339
frequently used, 357–360
keyframing, 349–354
masking and tracking, 347–349
Motion effect, 244–259
presets for, 339, 354–357
real-time playback of, 49–50, 51
removing from video, 339
rendering sequences with, 51, 360
source clip, 344–347
types of, 335–337

tracking
motion, 347, 349
text, 439

tracks, 12, 23
audio, 47–48, 283
explained, 135
locking, 168–170
selecting all clips on, 173
targeting, 136

transcoding files, 58, 69, 472
transcription feature, 39, 223, 224, 227, 463–464
Transform effect, 267–268
transitions, 184–207

audio, 203–205
copying/pasting, 195–196
customizing, 197–199
duration of, 193–194, 198, 202, 203
explanation of, 186–187
handles and, 188–189, 200–202
knowing when to use, 187–188
Morph Cut effect, 199–200
multiple-clip, 194–195
single-sided, 190–191
two-clip, 191–194
video, 189–196

transparency, 407, 408, 415–416, 445
trimming, 13, 199, 228–239

keyboard shortcuts for, 239
modifier keys to refine, 237
performing dynamic, 237–238
Program Monitor options for, 234–238
ripple edits for, 230–231
rolling edits for, 231–232
slide edits for, 233
slip edits for, 232–233
Source Monitor for, 228
Timeline panel for, 228–229

Type tool, 431, 438, 443, 446
typography essentials, 436–443

U
Ultra Key effect, 418–421
underexposed images, 391–393
user settings, 31

V
vector graphics, 80
Vector Motion effect, 253–254
vectorscope display, 380–383
Velocity graph, 351, 353–354
video

8-bit, 367
display format options, 53
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Web Edition of book, 3, 4
web link markers, 163
white balance, 394–399

curves for adjusting, 397–399
Lumetri color wheels for, 395–396
secondary color adjustment of, 396–397

workflow
color adjustment, 368–384
proxy media, 68–70
standard digital video, 11–12

workspaces, 16, 20–27, 486
Audio workspace, 275–277
Captions and Graphics workspace, 430
Color workspace, 369–370, 388
customizing and saving, 25–27
Editing workspace, 21, 122
Learning workspace, 24
Text-Based Editing workspace, 224

Workspaces menu, 21, 41, 186, 486

Y
YC waveform display, 378
YUV color, 337, 367
YUV effects, 337
YUV vectorscope, 380–383

Z
Zoom control, 100, 101, 105, 109, 146
Zoom Level menu, 107–108
zooming in/out, 109, 142, 191

Video Limiter effect, 388, 479
Warp Stabilizer effect, 357–359
See also audio effects

Video Limiter effect, 388, 479
video scopes, 375–376
vignette effect, 373
voice-overs

adjusting audio for, 307–325
recording, 83–84
See also dialogue adjustments

volume adjustments, 287–292
Audio Clip Mixer, 300–302
Effect Controls panel, 287–288
Essential Sound panel, 318
gain adjustments, 289–290
keyboard shortcuts for, 299
keyframes for making, 299–300
loudness settings and, 308–309
normalizing audio, 290–292
overall clip levels, 298

VR video
360° video vs., 162
display mode for, 14, 111
importing, 82
playing back, 162
Premiere Pro support for, 59, 82

W
Warp Stabilizer effect, 357–359
watch folders, 483
waveform display

audio waveforms, 281–282
Lumetri Scopes panel, 377–380
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